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RESUMEN 
 

El  estudio  se desarrolló en la zona norte del departamento del Huila, en el municipio de  
Villavieja y en la zona norte - este  de la Vereda Mesa Redonda del municipio de Tello, 
teniendo un área base de 51773,39 hectáreas.  

Con  fotografías aéreas georeferenciadas  de los años  1993, imágenes áereas satélite 
Landsat 5 años 1998, 2010, y Landsat 8 del año 2018, DEM ALOS PALSAR de 12.5 
metros, datos de precipitación y temperatura media anual de 6 estaciones  climatológicas 
del IDEAM,  utilizando el software AUTOCAD y ARCGIS 10.5, se realizaron los mapas 
temáticos de cobertura vegetal para los años 1993, 1998, 2010, 2018, se generaron los 
índices espectrales NVDI y SAVI para los años 1998,2010, 2018, se generó el mapa 
climático Caldas Lang para el periodo 1963 – 2014,  teniendo como primer indicador de 
criticidad en el proceso de desertificación  la cobertura de Suelo Expuesto se han obtenido  
los siguientes resultados se pasó en el año 1993 de  una área de 12153,5 Has (23.5%)  a 
13322.5 Has(25.8%) en el año 2018 , lo que nos da una velocidad promedio de 
desertificación de 46.8  Has/año, está concentrada en la parte centro sur y con una  
expansión leve hacia el norte.  

Los índices NDVI y SAVI nos permiten corroborar que las 2 mayores coberturas que 
indican el desarrollo de procesos de desertificación son pastos y suelo desnudo y sus 
cálculos están dando entre los rangos (1 a -1). 

El mapa climático Caldas Lang nos muestra los 3 tipos de clima presentes en la zona de 
estudio como son cálido árido, cálido húmedo  y templado cálido. 

 

PALABRAS CLAVES:  Desertificación, Desierto de la Tatacoa, ecosistema estratégico, 
SIG, cobertura vegetal, NVDI, SAVI, Caldas Lang 
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ABSTRACT 

 

The study was developed at the north zone of the department of Huila, in the municipality 
of Villavieja and in the north - east zone of the rural settlement of Mesa Redonda in Tello's 
municipality, having an area extends over 51773.39 hectares.  

With georeferenced aerial photographs of the years 1993, aerial satellite images Landsat 5 
years 1998, 2010, and Landsat 8 of the year 2018, DEM ALOS PALSAR of 12.5 meters, 
precipitation data and annual average temperature of 6 weather stations of IDEAM, using 
the software AUTOCAD and ARCGIS 10.5, the thematic vegetation cover maps were 
made for the years 1993, 1998, 2010, 2018, the NVDI and SAVI spectral indices were 
generated for the years 1998, 2010, 2018, the Caldas Lang climate map was generated for 
the period 1963 - 2014, having as the first indicator of criticality in the desertification 
process the Exposed Soil cover, the following results have been obtained: in 1993, from an 
area of 12153.5 Has (23.5%) to 13322.5 Has (25.8 %) in 2018, which gives us an average 
desertification speed of 46.8 Has / year, is concentrated in the south-central part and with a 
slight expansion towards the north. 

The NDVI and SAVI indices allow us to corroborate that the 2 largest covers that indicate 
the development of desertification processes are pastures and bare soil and their 
calculations are between the ranges (1 to -1). 

The Caldas Lang climate map shows us the 3 types of climates present in the study area, 
such as hot arid, warm humid and warm temperate. 

 

KEYWORDS:  Desertification, Tatacoa Desert, strategic ecosystem, GIS, vegetation 
cover, NVDI, SAVI, Caldas Lang 
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1. AREA PROBLEMÁTICA 

 
 
La desertificación es la degradación de las tierras áridas, semiáridas y zonas subhúmedas 
secas, causado principalmente por variaciones climáticas Y actividades humanas tales 
como el cultivo y el pastoreo excesivo, la deforestación y la falta de riego, según el 
Programa de las Naciones Unidas para el Medio Ambiente (PNUMA 1992).  

Al estar gran parte de la información del país del siglo pasado en sistemas analógicos, 
presenta el inconveniente de no poder  difundir o nos va a dificultar conocer la información 
de los procesos que se han dado sobre un territorio, o ubicarnos de una manera más precisa 
espacialmente en él. 

Más de 6.100 millones de hectáreas, casi 40% de la superficie del planeta son ecosistemas 
secos, parte de los cuales se han convertido en desiertos como consecuencia de actividades 
humanas, Colombia tiene una extensión de 2.070.408 km², de los cuales 1.141.748 km² 
corresponden a la extensión territorial, y 928.660 km² son extensión marítima, 245.342 
Km2 son zonas secas (21.5 %), que sumado a deforestación, ganadería intensiva y 
extensiva, minería, expansión de la frontera agrícola, mala planeación del crecimiento 
urbano, usos inadecuados de sistemas de producción y del agua, hacen que 78.9% de las 
zonas secas del país presentan algún nivel de desertificación derivado principalmente de 
procesos de erosión, compactación  y salinización (MINAMBIENTE 2020). 

En el departamento del Huila con una extensión de 19.900 Km2, en la parte norte  se 
encuentra el municipio de Villavieja con una extensión de 670 Km2, clasificadas 
bioclimáticamente como bs-T o bms-T, con suelos erodables que unidos a la acción 
antrópica han generado procesos de erosión en el área conocida como desierto de la 
Tatacoa (Olaya, Sánchez y Acebedo 2003). 

Cabe la pena preguntar ¿ Como, por medio de la consulta, recopilación y ordenamiento de 
la información analógica y digital existente,  reconstruir cartografía  que permita integrar, 
analizar y visualizar los diferentes procesos de la desertificación que se da en este 
ecosistema?. 
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2. OBJETIVOS 
 

2.1.OBJETIVO GENERAL 
 
Visualizar los procesos de desertificación del ecosistema  desierto de la Tatacoa, valorando 
la importancia de este fenómeno por su interrelación con otros ecosistemas y las 
poblaciones asentadas en la  región. 

 

2.2.OBJETIVOS ESPECÍFICOS 
 

• Identificar y delimitar el área general de estudio mediante cartografía,  fotografías 
aéreas, imágenes, o estudios  que existan en el periodo 1993-2018. 

 
• Generar los mapas temáticos de coberturas vegetales, del ecosistema desierto de la 

Tatacoa, para el periodo 1993-2018, utilizando el software ArcGis. 
 

• Calcular los índices espectrales NDVI (Normalized Difference Vegetation Index) y  
SAVI (Soil Adjusted Vegetation Index). 
 

• Calcular el índice de clasificación climática de  Caldas-Lang. 
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3. JUSTIFICACIÓN 
 

Revisando el Esquema de Ordenamiento Territorial (EOT) del Municipio de Villavieja, en 
uno de sus apartes, dice: “La ampliación de la frontera agrícola en tierras aptas para el riego 
o en secano para cultivos como el algodón, patilla, sorgo o arroz; ha generado que sus 
habitantes talen los árboles, deforesten zonas completas, aumenten el fenómeno de la 
desertización y fortalezcan el área de amenazas en ríos como el Magdalena, Cabrera y 
quebradas como Bateas. Tatacoa, Lajas y Arenosa entre otras. (EOT Municipio de 
Villavieja 2000). 

Según la ONU y el Ministerio de Ambiente, el 30 por ciento del territorio huilense está 
afectado por la desertificación en municipios cercanos a La Tatacoa, Baraya, Villavieja, 
Tello, Neiva, Aipe, Colombia, Yaguará, Rivera y Campoalegre (Revista Semana 2007). 
 

Es por esto necesario e interesante el poder contar con mapas actualizados y de épocas  
anteriores realizados por técnicas de fotointerpretación, utilizando un  software como 
AutoCAD y Arcgis para poder visualizar como se está desarrollando el fenómeno de la 
desertificación en esta región del país, así como utilizar la facilidad que existe hoy para la 
adquisición de imágenes satelitales, y también poder disponer  de datos hidroclimatologicos 
sin ningún costo, y apoyados en paquetes de software como Arcgis en su versión 10.5 
poder calcular índices espectrales, de pluviosidad, coberturas vegetales, analizando así con 
un soporte técnico y científico los procesos que se dan en el territorio y tener ese soporte 
para una futura toma de decisiones. 
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4. MARCO CONCEPTUAL  
 
Al ser la desertificación un proceso complejo ya que involucra muchas variables, se hace 
indispensable realizar clasificaciones de variables temáticas como población, suelo, agua, 
biota, para poder realizar comparaciones entre regiones de un país o del mundo, de ahí la 
importancia y necesidad del uso de indicadores que pueden ser de diferentes tipos como 
edáficos, climáticos, bióticos,  que tengan unos puntos de referencia a nivel universal, con 
un soporte técnico, científico, para ello podemos utilizar como insumos básicos para iniciar 
estos procesos fotografías aéreas bien sea a color o en niveles de grises, así como imágenes 
satelitales multiespectrales. 

4.1.FOTOGRAFÍA AÉREA 
 

La fotografía aérea es la imagen de un terreno captada desde un avión o cualquier otro 
equipo aéreo equipado con una cámara fotográfica, que contiene el registro completo y 
detallado de los elementos que conforman los fenómenos físicos del medio natural y de las 
acciones que el hombre ha realizado sobre él, este proceso se logra por la capacidad que 
tienen los cuerpos para absorber, refractar o dispersar la luz proveniente del sol, que al 
pasar por los lentes de la cámara lograr alterar la película o sensor que tiene la cámara en un 
mayor o menor grado,  a mayor capacidad de reflexividad de los objetos estos aparecen más 
claros en la fotografía, para poder utilizar esta fotografía aérea en procesos de elaboración 
de mapas es necesario convertirla en ortofotografia, con lo que se garantiza que todos los 
elementos están a la misma escala, libres de errores y deformaciones, (IGAC, 1991),   

 

4.2.IMAGEN SATELITAL 
 

Es la representación visual mediante la captura de la radiación electromagnética emitida o 
reflejada por la superficie de la tierra que captura un sensor instalado en un satélite 
artificial, existen diferentes tipos que dependen del tipo y de la finalidad de captación  del 
sensor, se utilizan con fines  militares, monitoreo del cambio climático, evaluaciones 
multitemporales de coberturas y usos del suelo, estas pueden ser generadas por sensores 
pasivos (energía del sol) o sensores activos (energía propia) como el radar. 

Hoy en día hay diferentes fuentes para la obtención de imágenes satelitales  
multiespectrales para los diferentes usos entre ellos tenemos las misiones de los satélites 
Landsat 5, con su sensor (Thematic Mapper (TM)), con una resolución espacial de 30 
metros, resolución temporal de 16 días,  tamaño aproximado es de 170 km sentido norte-sur 
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por 183 km sentido este – oeste, y Landsat 8, con sus sensores  (OLI) Operational Land 
Imager  y  (TIRS) Thermal Infrared Sensor, con una resolución espacial de 30 metros, 
resolución temporal de 16 días,  tamaño aproximado es de 170 km sentido norte-sur por 
183 km sentido este – oeste,  cuyas características de sus bandas se muestran en las tablas 1 
y 2 respectivamente acorde a (LANDSAT. 2020). 

Tabla 1.  Características imágenes Landsat 5  

Fuente: Landsat 2020 
 

Tabla 2.  Características imágenes Landsat 8  

BANDAS 
Longitudes de 
Onda μm 

Resolución 
espacial m. 

Aplicaciones 

BANDA 1 Violeta-Azul 0.45 – 0.52  
30 

Penetración del agua, uso 
de la tierra, vegetación 

sedimentos 

BANDA 2 Verde 0.52 – 0.60 
30 

Reflexión verde de la 
vegetación sana 

BANDA 3 Rojo 0.63 – 0.69 30 Trazado del uso de la tierra 

BANDA 4 IR cercano 0.76 – 0.90  
30 

Biomasa, identificar 
cultivos, limites tierra-agua 

BANDA 5 IR mediano 1.55 – 1.75 
30 

Cantidad de vegetación, 
zonas áridas, nubosidad, 

hielo, nieve 

BANDA 6 
IR lejano o 
térmico 

10.40 –12.50 
120-30 

Vigilancia, visión nocturna, 
detección de temperatura 

BANDA 7 IR mediano 2.08 – 2.35 
30 

Geología, formación de 
rocas 

BANDAS 
Longitudes de 

Onda μm 
Resolucion 
espacial m. 

BANDA 1 Aerosol costero 0.43-0.45 30 
BANDA 2 Azul 0.45-0.51 30 
BANDA 3 Verde 0.53-0.59 30 
BANDA 4 Rojo 0.64-0.67 30 
BANDA 5 Infrarrojo cercano -NIR 0.85-0.88 30 
BANDA 6 SWIR 1 1.57-1.65 30 
BANDA 7 SWIR 2 2.11-2.29 30 
BANDA 8 Pancromática 0.50-0.68 15 
BANDA 9 Cirrus 1.36-1.38 30 
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Fuente: Landsat 2020 
 

4.3.COBERTURA Y USO DE LA TIERRA. 
 

El análisis de las coberturas terrestres nos permite ver dinámica de cada una de ellas y su 
entorno, ya que no se refiere solo al término de vegetación y elementos antrópicos sino 
también a afloramientos rocosos y cuerpos de agua sean loticos o lenticos, se habla de uso 
cuando se muestra  la utilidad que presta un tipo de cobertura, se relaciona con las 
actividades humanas o las funciones económicas de un territorio al ser humano, (IDEAM 
2021). 

Un indicador del proceso de desertificación pueden ser la cobertura de suelo desnudo, 
analizando su relación con otras coberturas como, pastos, bosques, y cultivos, de acuerdo a 
la metodología Corine Land Cover, CORINE (Coordination  of Information on the 
Environment), que definió una metodología específica para realizar el inventario  de la 
cobertura de la tierra, y en Colombia promovido y desarrollado entre otros institutos por el  
IDEAM, IGAC, CORMAGDALENA a partir de una línea base (2000-2002) y a una  escala 
1:100.000, (IDEAM, et. al. 2008), por lo que es fundamental realizar el trabajo en un 
ambiente SIG para lograr la integración de todos los datos.  

 

4.4.ÍNDICES ESPECTRALES. 
 

Los índices espectrales son el resultado de realizar una operación algebraica con  dos o más 
bandas de una imagen buscando resaltar una característica especifica del terreno como 
puede ser agua, suelo o vegetación, esto está asociado a que cada material tiene una firma 
única conocida como la firma espectral que es la reflectancia como una función de longitud 
de onda de cada uno (USGS, 2021). 

BANDA 
10 

Infrarrojo térmico 
(TIRS) 1 

10.6-11.19 100 

BANDA 
11 

Infrarrojo térmico 
(TIRS) 2 

11.50-12.51 100 
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Al disponer de las bandas se pueden complementar los estudios de le vegetación presente 
en la zona calculando índices espectrales, para categorizar, agrupar y evaluar, monitorear el 
estado de la vegetación, unos de estos índices son el  NDVI o índice de vegetación 
normalizado (NDVI = (NIR-RED) / NIR+RED), con un rango de variación fijo (entre –1 y 
+1)  donde valores negativos indican presencia de agua, del orden de 0 a 0.2, corresponden 
a áreas rocosas, arenosas, entre 0.2 y 0.4 corresponden a áreas con vegetación escasa; entre 
0.4 y 0.6 a vegetación moderada y  por encima de 0.6 una mayor densidad de hojas verdes  
y el  SAVI  o índice de vegetación ajustada al suelo (SAVI =[(IRC–R)/(IRC+R+L)] (1+L)), 
donde el  valor L, para corregir los efectos del ruido del suelo (color, humedad del suelo), 
con la densidad de la vegetación ( Muñoz, 2013). 

 

4.5.CLASIFICACIÓN CLIMÁTICA. 
 

La clasificación climática es una forma de categorizar el clima de una región  asociado a 
sus pisos térmicos, precipitación, temperatura, evapotranspiración, radiación, los sistemas 
de información geográfica han pasado de hacer análisis estadísticos clásicos a procesos 
donde la relación espacial es fundamental para la modelación de comportamientos, las 
clasificaciones climáticas de mayor reconocimiento en el país, son Köppen, Thornthwaite, 
Caldas, Lang, Caldas-Lang, Martonne y Holdridge, clasificaciones basadas principalmente 
en el comportamiento medio de la precipitación y la temperatura (Medina, Aldana, 2019). 

4.5.1. Clasificación  de Caldas 

 
La de mayor reconocimiento en Colombia fue concebida por Francisco José de Caldas en 
1802. Su aplicabilidad es exclusiva para el los países tropicales (tabla 3). 

Tabla 3.  Clasificación climática de Caldas 
PISO TÉRMICO  RANGO 

ELEVACIÓN  
RANGO 
TEMPERATURAS  

SIMBOLO 

CÁLIDO  0 a 800 T>=24°C C 
TEMPLADO  800 a 1800 24°C>T>18°C T 
FRÍO  1800 a 2800 18°C>T>12°C F 
MUY FRÍO  2800 a 3700 12°C>T>6°C MF 
EXTREMADAMENTE 
FRÍO  

3700 a 4700 6°C>T>0°C EF 

NIVAL  >4700 T< 0°C N 
Fuente: IDEAM 2020 
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4.5.2. Clasificación  de Lang 

Se logra mediante el cociente entre la precipitación media anual, expresada en milímetros, 
y la temperatura media anual en °C., se obtienen 6 categorías de clima (tabla4) 

Tabla 4.  Clasificación climática de Lang 
FACTOR HUMEDAD  FACTOR DE LANG (P/T)  SIMBOLO 
DESÉRTICO  0 A 20  D 
ÁRIDO  20.1 A 40.0  A 
SEMIÁRIDO  40.1 A 60.1  Sa 
SEMIHÚMEDO  60.1 A 100  Sh 
HÚMEDO  100 A 160  H 
SUPERHÚMEDO  >160  SH 

Fuente: IDEAM 2020 
 

4.5.3. Clasificación  de Caldas Lang 

El geólogo suizo Paul Schaufelberguer en 1962, combinó la clasificación de Caldas con la 
de Lang, es una de las más utilizadas en el país. Cada tipo de clima se nombra con dos 
palabras: la primera describe su característica térmica y la segunda describe su estado de 
humedad promedio (tabla5). 

Tabla 5.  Clasificación climática de Caldas Lang 
TIPOS DE CLIMA  SIMBOLO 
CÁLIDO SUPERHÚMEDO  CSH 
CÁLIDO HÚMEDO  CH 
CÁLIDO SEMIHÚMEDO  CsH 
CÁLIDO SEMIÁRIDO  Csa 
CÁLIDO ÁRIDO  CA 
CÁLIDO DESERTICO CD 
TEMPLADO SUPERHÚMEDO TSH 
TEMPLADO HÚMEDO  TH 
TEMPLADO SEMIHÚMEDO  Tsh 
TEMPLADO SEMIÁRIDO  Tsa 
TEMPLADO ÁRIDO  TA 
TEMPLADO DESERTICO TD 
FRÍO SUPERHÚMEDO  FSH 
FRÍO HÚMEDO  FH 
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FRÍO SEMIHÚMEDO  FsH 
FRÍO SEMIÁRIDO  Fsa 
FRÍO ÁRIDO  FA 
FRIO DESERTICO FD 
MUY FRÍO BAJO SUPERHÚMEDO  MFBSH 
MUY FRÍO BAJO HÚMEDO  MFBH 
MUY FRÍO BAJO SEMIHÚMEDO  MFsh 
MUY FRÍO BAJO SEMIÁRIDO  MFsa 
MUY FRÍO BAJO ÁRIDO  MFBA 
EXTREMADAMENTE FRÍO SUPERHÚMEDO  EFSH 
EXTREMADAMENTE FRÍO HÚMEDO  EFH 
EXTREMADAMENTE FRÍO SEMIHÚMEDO  EF 
EXTREMADAMENTE FRÍO SEMIÁRIDO  EFsa 
EXTREMADAMENTE FRÍO ÁRIDO  EFA 
NIVAL SUPERHÚMEDO  NSH 
NIVAL HÚMEDO  NH 
NIVAL SEMIHÚMEDO  Nsh 
NIVAL SEMIÁRIDO  Nsa 
NIVAL ÁRIDO  NA 

Fuente: IDEAM 2020 

5. MARCO REFERENCIAL 
 

En la Convención de las Naciones Unidas de Lucha Contra la Desertificación, se 
conceptualizó este último término como la degradación de las tierras y de la vegetación, la 
erosión de los suelos y de las tierras fértiles en las áreas áridas, semiáridas y subhúmedas 
secas, causada principalmente por las actividades humanas y por las variaciones del clima. 
La sequía puede desencadenar o agravar la desertificación, la desertificación es la 
consecuencia de un conjunto de procesos activos en ambientes áridos y semiáridos, dónde 
el agua es el principal factor limitante de la Productividad en los ecosistemas (Kirby y 
Kosmas, 1999), también genera merma en la producción de alimentos, incrementa los 
costos sociales, disminuye la suplencia de agua fresca en cantidad y calidad, aumenta la 
pobreza e inestabilidad política, reduce la resiliencia de las tierras debido a la variabilidad 
climática y la productividad (UNCCD, 1994). 
 
Otra definición de desertificación la da La Convención de las Naciones Unidas de Lucha 
Contra la Desertificación y la Sequía (UNCCD), “la reducción o pérdida de la 
productividad biológica o económica del sistema bioproductivo terrestre que comprende el 
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suelo, la vegetación, otros componentes de la biota y los procesos ecológicos e 
hidrológicos, especialmente en los ecosistemas de las zonas secas (áridas, semiáridas y 
subhúmedas secas), debido a los sistemas de utilización de la tierra o por un proceso o 
combinación de procesos, incluidos los resultantes de actividades humanas y factores 
climáticos” (IDEAM, IGAC, MAVDT, 2010). 
 
La desertización es el proceso natural en el que a través del tiempo un territorio pierde sus 
características de fertilidad y se transforma en desierto, diferente el conocido como 
desertificación en donde las tierras de las regiones áridas, semiáridas y subhúmedas sufren 
degradación debido a la acción combinada de las variaciones climáticas y las actividades 
humanas, en el mundo aproximadamente el 32% de la población mundial, el 67% de los 
países y el 40% de la superficie terrestre son directa o indirectamente afectados por este 
fenómeno, desde las reformas rurales en la década de 1980, los gobiernos estatales y locales 
de China han dedicado grandes esfuerzos a combatir la desertificación a través de una serie 
de campañas de restauración ecoambiental, (Jinya et al 2017), además afecta 
aproximadamente un 40% del planeta y un 70% de todas las tierras secas muestran 
procesos de desertificación (Holtz, 2003), como se puede observar en el mapa  mundial de 
desertificación y vulnerabilidad de 1998. (Ver Figura1). 
 
Estudios realizados entre 1981 y 1999 han demostrado recuperación de vegetación en zonas 
del Sahel al norte del continente africano, también la disminución de la superficie del 
desierto del Sahara, así como reversión de  la desertificación en regiones del África 
subsahariana, del Mediterráneo y América del Norte (Qiu et. al. 2018) 
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Figura 1. Mapa Mundial Desertificación y Vulnerabilidad 
Fuente: U.S. Departament of Agriculture 1998 

 

Procesos como la erosión, la compactación de suelos, la variabilidad climática, el uso de 
tecnologías y prácticas agrícolas no amigables con el medio ambiente pueden ocasionar 
pérdida y fertilidad del suelo, llegando a producir aridez y desertificación, es por esto que el 
Ministerio de Ambiente y Desarrollo Sostenible formuló la Política para la Gestión 
Sostenible del Suelo, buscando lograr de manera integral la conservación de la 
biodiversidad, el agua y el aire, el ordenamiento del territorio y la gestión de riesgo, 
contribuyendo al desarrollo sostenible y al bienestar de los colombianos (MINAMBIENTE 
2020), factores de  orden climático que tienen influyen  en el origen y degradación de los 
suelos y tierras   de las zonas áridas o desérticas son los fenómenos de variabilidad 
climática en lo referente a la precipitación, El niño (escasez), La niña (exceso) (Vargas, 
Gómez, 2003). 
 

La Corporación Autónoma Regional de Cundinamarca (CAR), administra la Sabana de 
Bogotá y los valles de Ubaté y del río Suárez, con un área de 1.870.640 hectáreas, la cual  
presenta una erosión severa y muy severa  que suma el 9% de su territorio  unas 168358 
hectáreas, (Gómez 2019). 

En el Huila 15 de los 37 municipios presentan niveles de desertificación, siendo Altamira, 
Hobo, Paicol, Palermo, Villavieja y Yaguará,  los que presentan los más altos o críticos, (La 
Nación 2012), también se encuentra el ecosistema seco llamado desierto de La Tatacoa, el 
cual presenta tendencia a la desertificación  con fuertes procesos erosivos por ser sus suelos 
erodables, desplazamiento de masas de aire seco e  intensas precipitaciones concentradas en 
pocos días durante el año (Rojas 2019). 

En Colombia la desertificación con relación a los departamentos. (Ver. Figura 2). 
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Figura 2. Colombia Departamentos Susceptibles a Desertificación  

Fuente: Siac.org.co 2010 
 
 
 
 
 
 

6. METODOLOGÍA 
 

La metodología es de carácter descriptivo-cuantitativo ya que busca visualizar el fenómeno 
de la desertificación que se presenta  en el ecosistema estratégico Desierto de la Tatacoa, 
ver figura 3. 
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Figura 3. Imagen Satelital Área de Estudio 
Fuente: Google Earth 2018 

 
Por medio de un análisis multitemporal de fotografías  aéreas e imágenes satelitales, todo la 
cartografía está referenciada acorde  a la Resolución 471 de 2020 (IGAC)  que establece un 
sistema de proyección cartográfico con un único origen para Colombia, “origen nacional”, 
el sistema de Proyección es CTM12 (Proyección Conforme Transversa de Mercator 
amplitud 12 ° de Longitud), se debe configurar en Arcgis de la siguiente forma:  
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► Abrir ArcMap, ir a   
► View > Data Frame Properties, en la pestaña Coordinate System,   
► Dar clic en el icono (Add Coordinate System),   
► Seleccionar: New > Projected Coordinate System, se abre la ventana  
► New Projected Coordinate System, se debe configurar como se observa en la figura 4.,  
► Se da Change,  abre la ventana Spatial Reference Properties,   
► El sistema geográfico del cual se deriva esta Proyección corresponde al Datum MAGNA, 
► Se escribe MAGNA y buscar,  
► Se da Aceptar,  
► Luego Aceptar y Aplicar. 
 

 
Figura 4. Configuración para sistema de proyección CTM12. 

 
Se puede aplicar a cualquier sistema de referencia, Coordenadas Geográficas, Coordenadas 
Datum Bogotá, Datum MAGNA  para proyectar al nuevo sistema se debe: 
 
►  Abrir ArcMap, adicionar los layers, para migrar estas capas al nuevo Sistema de 
Referencia único Nacional,  
► Se va a Arcmap > ArcToolbox > Data Management Tools > Projections and 
Transformations > Batch Project y doble clic,   
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► Se cargan los archivos, se define la carpeta de salida de da el nuevo sistema de 

coordenadas, ok, y todo queda como se observa en la figura 5: 
 

 

 
Figura 5.  Archivos migrados al sistema de proyección CTM12. 

 
Se tomó como base cartográfica y área del presente trabajo la determinada en  el estudio 
“Formulación del plan de manejo y declaratoria como área natural protegida del Desierto 
de La Tatacoa”, desarrollado  por la Corporación Autónoma Regional del Alto Magdalena 
(CAM), se utilizaron fotografías aéreas IGAC tal como está indicado en la tabla3,  se inició 
con la  georeferenciación de todas las 12 fotografías, se realizó  la fotointerpretación  
teniendo en cuenta elementos relevantes de la fotografía aérea como son: tamaño, tono, 
colores de grises y textura (Chuvieco1995), para lograr la respectiva interpretación y 
proceder a realizar los mapas para las coberturas  vegetales presentes en  la zona como son:  
áreas de Agua, Cultivos, Bosques, Pasto, y Suelo desnudo, para ellos se utilizó los software 
AutoCAD y Arcgis en su versión 10.5, para el presente estudio solo se toman los niveles I y  
II por el nivel de  detalle básico de la metodología Corine Land Cover.  

 
 
 

Tabla 6.  Fotografías aéreas y línea de vuelo 

Línea de 
Vuelo 

Año Fotografías Total Cámara Distancia 
Focal ( f =mm) 

Escala 
Media 
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Fuente: Autor Estudio 

Para completar el periodo de tiempo de 25 años 1993-2018 se procesaron las imágenes 
satelitales del United States Geological Survey (USGS), descargadas de la página Earth 
Explorer, correspondientes a las misiones de satélites Landsat 5 y Landsat 8 (Land=Tierra, 
Sat= Satélite), cuyas características se ven en las  tablas 1 y 2 respectivamente,  ubicadas en  
la zona PATH= 008, ROW= 058, con una resolución de 30 metros, cada escena cubre 
180*175 Km2, buscando que presenten una mínima cobertura de nubes, se utilizaron la 
imágenes como se observa en la tabla 7, por lo cual los periodos de análisis serán de los 
años 1993 – 2001 periodo de 12 años, años 1998 – 2010 periodo de 9 años y años 2010 – 
2018 periodo de 8 años, buscando como se ve una periodicidad similar tanto en años como 
en meses de captura de la imagen.  

Tabla 7.  Imágenes Landsat utilizadas. 
MISION  AÑO SENSOR CODIGO 
Landsat 5 1998 TM LT05_L1TP_008058_19980630_20161223_01_T1 
Landsat 5 2010 TM LT05_L1TP_008058_20100122_20161017_01_T1 

Landsat 8 2018 OLI_TIRS LC08_L1TP_008058_20180317_20180403_01_T1 
Fuente: Autor del estudio 

 
El procesamiento y análisis de las imágenes Landsat se realizó con software Arcgis en su 
versión 10.5, se procedió  a  realizar: 

1. Corrección por reflectancia, que busca calibrar los valores del número digital (DN) 
de las imágenes de algunos sensores de satélite, se utiliza la elevación del sol, la 
fecha de adquisición, la ganancia y sesgo del sensor de cada banda para obtener la 
reflectancia de la parte superior de la atmósfera, más la corrección del ángulo solar 
(ESRI 2021), esta información se obtiene de cada imagen satelital en el archivo 
MTL, para ello se procede así: 
  
► Se va a Arcmap, se carga la banda de la imagen,  
► Vamos a ArcToolbox > Spatial Analyst Tools > Map Algebra > Raster 
Calculator, 
► Se aplica la formula ((RM * ND) + RA) / sen ᾳ   
► Donde ᾳ = ángulo de elevación Solar, ND = Número digital de la banda,  
RA= Reflectancia adicional de la banda, RM= Reflectancia especifica de la banda. l 
► Se da OK, para generar el respectivo archivo raster de salida. 

C 2520 1993 
193-192-191-190- 
212-213-214-215- 
231-230-229-228 

12 153 1:49850 
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2. Se monta el archivo shp correspondiente al área de estudio,  

► Se extrae el área de cada banda utilizando la siguiente secuencia haciendo el 
respectivo recorte de la imagen por cada una de sus bandas así:  
► ArcToolbox > Spatial Analyst Tools > Extraction > Extract by Mask,  
► Creando el respectivo archivo de salida para cada banda. 
 

3. Luego se generó la combinación de bandas para lograr la respectiva imagen en este 
caso las siguientes composiciones con archivos Landsat 5 la 5,4,3 y para Landsat 8 
la 6,5,4 con las cuales se diferencian agua (negro, azul), suelo (violetas, rojizos), 
vegetación (verdes), para ello utilizamos:  
► ArcToolbox > Data Management Tools > Raster> Raster Processing > 
Composite Bands 
► Doble clic se montan los archivos raster en el orden de la combinación,  
► Se da nombre al archivo de salida y OK. 
 

4. Se procede a la creación de las firmas espectrales para la respectiva combinación de 
bandas por año, para ello: 
  
► Utilizamos la barra de herramienta de Image Classification,  
► Iniciamos cargando el respectivo raster de la combinación de bandas,  
► Crear polígonos, realizamos los respectivos polígonos por cada una de las 
coberturas a analizar, buscando que la unión de todos ellos por cobertura nos de un 
Count mayor de 100,  
► Para agruparlos utilizamos el botón Training Sample Manager,  
► Después de creadas todas las coberturas para nuestro caso Agua, Cultivo, 
Bosque, Pasto y Suelo,  
► Procedemos en Training Sample Manager a marcar  
► Créate  a Signature File,  
► La guardamos con su extensión .gsg 

 
5. Se realiza la respectiva clasificación supervisada, para ellos vamos a: 

 
► Image Classification > Classification > Maximum Likelihood Classification,  
► Se monta el raster de la composición de bandas, la firma espectral creada, se deja 
lo otro por defecto  
► Se da OK, generando así el respectivo archivo raster de las clases de coberturas 
calculadas, con su respectiva tabla de atributos como se observa en la figura 6. 
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Figura 6.  Tabla de atributos Cobertura vegetal 2018 

 
6. Procedemos a eliminar el ruido del archivo raster generado para ellos utilizamos la 

herramienta Majority Filter como sigue a continuación: 
  
► Vamos a ArcToolbox > Spatial Analyst Tools > Generalization > Majority Filter, 
► Se carga el archivo raster de la clasificación,  
► Se maneja el valor de 8 vecinos Eigth,  
► Se crea el respectivo raster sin ruido de la clasificación.  
 

7. Calculamos el índice espectral NDVI (Índice diferencial de vegetación 
normalizado), para ello utilizamos la calculadora raster utilizando la respectiva 
formula NDVI = (NIR – Red) / (NIR + Red), se continua así: 
 
► ArcToolbox > Spatial Analyst Tools > Map Algebra > Raster Calculator,  
► Se escribe esta expresión  para (Landsat 4–7)NDVI = Float (B4 – B3) / Float (B4 
+ B3),  
► Si es  (Landsat 8) NDVI = Float (B5 – B4) / Float (B5 + B4),   
► Se da OK y generamos el archivo raster NVDI. 
 

8. Ahora calculamos el índice espectral SAVI (Índice de Vegetación Ajustado al 
Suelo), para ello utilizamos la calculadora raster utilizando la formula: 
 
► SAVI = ((NIR - R) / (NIR + R + L)) * (1 + L). 
Donde (L) factor de corrección de la luminosidad del suelo  definido en 0.5 para 
acomodar la mayoría de los tipos de cobertura del suelo (USGS, 2020), se realizó lo 
siguiente: 
►  ArcToolbox > Spatial Analyst Tools > Map Algebra > Raster Calculator  
► Para (Landsat 4–7)  
SAVI= Float ((B4–B3) / Float ((B4–B3) / Float (B4 + B3 + 0.5)) * (1.5),  
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► Para Landsat 8,  
SAVI = Float ((B4–B3) / Float ((B4 – B3) / Float (B4+B3 + 0.5)) * (1.5),  
► Se da OK y generamos el archivo raster SAVI. 

 
Para calcular el índice de clasificación climática de  Caldas-Lang se tomó la información de 
la precipitación media anual, expresada en milímetros, y la temperatura media anual en °C, 
suministrada por el Instituto de Hidrología, Meteorología y Estudios Ambientales 
(IDEAM), proveniente de 6 estaciones agrupadas entre los 328 msnm y los 500 msnm, 
agrupando información como lo son el código de la estación, nombre, elevación a la que se 
encuentra la estación, coordenadas  (Latitud y Longitud) en grados, coordenadas planas 
origen nacional (Este, Norte) en m., precipitación media anual en mm, temperatura  media 
anual en °C, municipio al que pertenece, utilizando el software Magna Sirgas 5 del IGAC, 
se convierten las coordenadas geográficas a planas origen único nacional, las estaciones 
que se encuentran tanto dentro como alrededor del área de estudio son La Yeguera, Villa 
Vieja FFCC, San Alfonso, El Tomo, Mesa Redonda, y Anchique, como se puede ver en la 
tabla 8. 

Tabla 8.  Estaciones climatológicas zona de estudio. 

CODIGO ESTACION ALTURA 
Latitud 

N 
Longitud 

W 
X ESTE Y NORTE 

PRE. 
mm 

TM °C Municipio 

21115060 San José 400 3,19 75,11 4757492 1924766 1138,2 28,2 Villavieja 

21110120 La Yeguera  400 3,18 75,12 4755636 1922927 1226,5 28,6 Villavieja 

21115080 
Villa Vieja 

FFCC 
430 3,13 75,12 4755616 1913713 1122,3 27,9 Villavieja 

2114504 San Alfonso 440 3,22 75,06 4766764 1930274 1028,0 28,6 Villavieja 

21140110 El Tomo  444 3,2 75,05 4768608 1926584 955,1 28,3 Villavieja 

21110160 
Mesa 

Redonda  
500 3,07 75,11 4757445 1902652 1168,7 28,6 Tello 

21135030 Anchique 415 3,34 75,08 4763110 1952395 1483,6 28,0 Natagaima 

Fuente: Autor del estudio 

Con los datos de precipitación y temperatura, utilizando el software Arcgis en su versión 
10.5  se calculó el índice de Lang, datos en la tabla 4.   

1. Se carga en Arcgis la tabla 3 de estaciones que está en excel,  
► Se adiciona la hoja que contiene los datos del archivo de excell,  
► Clic con el  botón derecho del mouse,  data exportar como .dbf,  
► Al archivo creado clic con el  botón derecho del mouse y   
► Add XY Data, organizar las columnas, definir el S. Coordenadas, seguidamente  
► Exportar la tabla como shapefile (Clic derecho sobre la capa > Data > Export 
Data). 
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2. Con el archivo shp generado de las estaciones se realiza la interpolación en el área 

de estudio de la precipitación y de la temperatura así:  
 
► ArcToolbox > Spatial Analyst  >  Interpolation > IDW  (Inverse Distance 
Weighted), método de ponderación inverso a la distancia, este algoritmo calcula los 
valores de las celdas por medio de una composición ponderada de los datos de la 
muestra, el modelo sugiere que el resultado predicho reduce su incidencia en la 
medida en que aumenta la separación entre el punto a evaluar y los puntos de su 
entorno,  pronostica valores más cercanos a los observados (Garzón 2013),  
► En la columna z se colocan los datos de precipitación o de temperatura,  
► Luego Enviroments > Processing Extent > seleccionamos el polígono o área, 
► Seguimos a Raster Analysis, Mask y seleccionamos el área donde se va a 
interpolar,  
► Se da OK,  
► OK y se generan los respectivos archivos raster de precipitación y temperatura. 
 
 

3. Con los archivos raster generados de precipitación y temperatura se procedió a 
calcular el mapa de clasificación de Lang, para ello vamos a  
► ArcToolbox > Spatial Analyst Tools > Map Algebra > Raster Calculator,   
► Se escribe la operación de división de la precipitación entre la temperatura, 
"precip.tif" / "temp.tif" 
► OK, se genera el mapa, se procedió a reclasificarlo acorde a los rangos de la tabla 
4, para ello sobre el archivo tiff creado,  
► Clic con el  botón derecho del mouse,  Propiedades > Simbology > en la nueva 
ventana generada  
► Clasified >Clasify,  se da el número de clase y los rangos  
► se da OK, OK, para terminar el proceso 

Ya con el coeficiente de Lang calculado, se descargó del satélite ALOS  sensor 
PALSAR, los 2 archivos DEM de 12.5m, con una profundidad de pixel de 16 bit, que 
fueron el  AP_24770_FBD_F0050_RT1.dem.tif y el 
AP_24347_FBD_F0050_RT1.dem.tif para con ellos y utilizando el software Arcgis 
10.5, generar un mosaico, recortar la zona de estudio y crear un mapa de curvas de nivel 
para la zona, y así ubicar los pisos térmicos presentes en la zona de estudio, que al ser 
combinados con el coeficiente de Lang, poder generar el mapa climático de Caldas-
Lang, así: 
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1. Se cargan los 2 archivos DEM, en arcmap, vamos a  
► Image Analysis > seleccionamos los 2 DEM > Processing > Mosaic y generamos 
el mosaico,  
► Luego ArcToolbox > Spatial Analyst Tools > Extraction > Extract by Mask,  
► Se monta el mosaico generado y se recorta con el SHP del área de estudio, 
generando el DEM del área de estudio en formato .tiff, lo reclasificamos acorde a 
los pisos térmicos de Caldas 
 

2. Se combinan los 2 raster el índice de Lang con los pisos térmicos de Caldas:  
► ArcToolbox > Spatial Analyst Tools > Map Algebra > Raster Calculator, 
► Se realiza la suma de los 2 raster,  para  generar el mapa climático  Caldas-Lang. 
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7. RESULTADOS 
 

7.1.IDENTIFICACIÓN Y DELIMITACIÓN DEL ÁREA GENERAL DE 
ESTUDIO 

Para la identificación y delimitación de la zona de estudio  se tomó como base cartográfica 
y área del presente trabajo la determinada en  el estudio “Formulación del plan de manejo y 
declaratoria como área natural protegida del Desierto de La Tatacoa”, desarrollado  por la 
Corporación Autónoma Regional del Alto Magdalena (CAM), con una extensión de 
51773,4 Hectáreas, en jurisdicción del municipio de Villavieja, la cual está delimitada por 
el norte con el municipio de Natagaima (Tolima), por el oriente con los municipios de 
Alpujarra (Tolima) y Baraya (Huila), por el occidente con el municipio de Aipe (Huila) y 
por el sur con los municipios de Baraya y Tello (Huila). La delimitación del área general 
del estudio definió el punto de partida para el desarrollo cartográfico temático, y las 
condiciones de análisis ecológico de la zona. 

 

7.2.GENERACIÓN DE MAPAS TEMÁTICOS. 
 

Mediante el uso del software Arcgis 10,5 a partir del área base y con las fotografías aéreas 
suministradas por el IGAC Tabla 6 (año 1993) y georeferenciadas, las imágenes satelitales 
Landsat 5 (años 1998, 2010) y Landsat 8 (año 2018), Tabla 7, se obtuvieron los mapas 
temáticos que corresponden a cobertura vegetal y usos del suelo, para los respectivos 
momentos o periodos de tiempo.  

Las convenciones utilizadas en todos los desarrollos cartográficos, se relacionan con los 
siguientes temas como se observa en la tabla 9, así como los valores de áreas y porcentajes 
en la tabla 10. 

La escala de los mapas generados es de 1:50.000. 
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Tabla 9. Convenciones coberturas vegetales y usos del suelo presentes en la zona de estudio 
Tipo de 

Cobertura 
Descripción -  Referencias 

Bosques. Bo 

(del b. lat. boscus), m. Sitio poblado de árboles arbustos y matas,  cuando 
se establece en las riberas de una corriente de agua o masa de agua se llama 
bosque de  galería o ribereño (PÍO Font Quer 2001), Hace referencia a las 
coberturas vegetales representadas en especies arbóreas, principalmente las 
asociadas a riberas de ríos y quebradas, y algunos “parches” boscosos en 
otras zonas, como las estribaciones y las partes altas de algunos cerros. 

Pasto 
Natural 

Pn. 
Hace referencia a la cobertura vegetal mínima, representada por pasturas 
naturales, de porte bajo o rastrero. 

Suelo 
Expuesto 

Se 

Muestra las condiciones de criticidad en los suelos, en donde se ha perdido 
la cobertura vegetal de manera permanente, y el proceso de erosión y 
desertización es progresivo. Es de tener en cuenta que esta cobertura 
incluye pequeñas asociaciones de suelo expuesto con especies de cardos, 
pequeños arbustos y herbáceas de bajo porte. 

Cultivos Cu 
Representa la presencia de coberturas vegetales resultantes de actividades 
antrópicas, ya sea de manutención o consumo propio, o para actividades 
comerciales. 

Agua A 
Indican la presencia de cuerpos de agua lenticos, o loticos ya sean naturales 
o artificiales. 

Fuente: Autor Estudio 
 

Tabla 10. Áreas de coberturas vegetales y usos del suelo presentes en la zona de estudio 

Tipo de 
Cobertura 

1993 1998 2010 2018 
Area 
(Has) 

% 
Area 
(Has) 

% 
Area 
(Has) 

% 
Area 
(Has) 

% 

Agua 1062,9 2,1 986,4 2.2 1313,6 2,5 1029,7 2,0 

Cultivo 6039,3 11,7 1234,0 3.1 1066,0 2,1 1528,7 3,0 

Bosque 11521,8 22,3 17410,7 21.2 15356,9 29,7 14681,1 28,4 

Pasto 20996,0 40,6 12468,1 40.1 21374,2 41,3 21150,9 40,9 

Suelo 
Expuesto 

12153,5 23,5 19613,8 33.4 12602,3 24,4 13322,5 25,8 
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TOTAL 51773,4 100 51712,9 100 51712,9 100 51712,9 100 

Fuente: Autor Estudio 
 

Realizados los respectivos análisis para cada año, se obtienen  las diferentes coberturas del 
área de estudio para los años  1993, 1998, 2010, 2018, de acuerdo a la tabla anterior,  y 
apoyados en el software Excel, con base en esta distribución temporal, los resultados 
cuantitativos y porcentuales fueron los siguientes que se observan en la figura 7: 

 

Figura 7.  Coberturas Vegetales y Usos del Suelo en Porcentajes Años 1993, 1998, 2010 y 
2018 

Fuente: Autor Estudio 
 

7.3.COBERTURA VEGETAL Y USOS DEL SUELO – AÑO 1993. 
 

Como se observa en la figura 7 y Mapa 1, la cobertura vegetal más significativa 
corresponde a la de pastos, con un 40.6% del área total de estudio, equivalente a 20996 
hectáreas. Esto implica que las actividades humanas  principales estaban relacionadas con 
el sector pecuario, en donde posiblemente por efectos de ampliar las zonas de pastoreo, es 
necesaria la intervención de algunas zonas boscosas.  

Las coberturas que siguen en porcentaje de ocupación, para el año en referencia, 
corresponden a Suelo Desnudo con un 23.5%,  Bosques con 22.3%, estos valores muestran 
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una secuencia de ocupación directamente relacionada con las actividades antrópicas de la 
época, ya se podía observar la afectación de la actividad del pastoreo representada en la 
pérdida de cobertura vegetal con la consecuente aparición de suelos expuestos y el riesgo 
de afrontar procesos erosivos y de empobrecimiento en su fertilidad. 

Los valores más bajos corresponden a cultivos y agua con el 11.7% y 2.1% 
respectivamente. 

 
Mapa 1. Cobertura Vegetal y Usos del Suelo - 1993 

Fuente: Autor Estudio 
7.4.COBERTURA VEGETAL Y USOS DEL SUELO – AÑO 1998 
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Como se observa en la figura 7 y Mapa 2, la cobertura vegetal más significativa 
corresponde a la de pastos, con un 40.6% del área total de estudio, equivalente a 20745,5 
hectáreas, siguen Suelo Desnudo con un 23.5%,  Bosques con 21.2%,  cultivos con un 3,1% 
y el Agua con un 2.2%, lo que nos indica que la dinámica de las coberturas y usos del suelo 
no presentan en comparación con las coberturas y usos del año 1993 para este periodo de 5 
años. 

 
Mapa 2. Cobertura Vegetal y Usos del Suelo - 1998 

Fuente: Autor Estudio 
7.5. COBERTURA VEGETAL Y USOS DEL SUELO – AÑO 2010.  
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Como se observa en la figura 7 y Mapa 3, la cobertura vegetal más significativa 
corresponde a la de pastos, con un 41.3% del área total de estudio, equivalente a 21374,2 
hectáreas, siguen en porcentaje de ocupación Bosques con 29,7%, Suelo Desnudo con un 
24.4%, Agua con el 2,5% y finalmente Cultivos con el 2,1%, por lo que es posible decir 
que la dinámica sigue siendo similar con los periodos de 1993 y 1998. 

 
Mapa 3. Cobertura Vegetal y Usos del Suelo - 2010 

Fuente: Autor Estudio 
7.6.COBERTURA VEGETAL Y USOS DEL SUELO – AÑO 2018 
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Como se observa en la figura 7 y Mapa 4, la cobertura vegetal más significativa es 
nuevamente pastos, con un 40.6% del área total de estudio, equivalente a 21150,9 
hectáreas, siguen Bosques con 28,4%,  Suelo Desnudo con un 25,8%,  Cultivos con 3.0% y 
2,0% para el Agua, sin presentar cambios bruscos en las tendencias  de coberturas ni usos 
del suelo en estos últimos 25 años. 

 
Mapa 4. Cobertura Vegetal y Usos del Suelo - 2018 

Fuente: Autor Estudio 
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7.7.CÁLCULO ÍNDICE ESPECTRAL NDVI (NORMALIZED DIFFERENCE 
VEGETATION INDEX). 

 
Para el cálculo de este índice se utilizó la formula NDVI = (NIR-RED) / NIR+RED para 
los años 1998 y 2010 se descargaron imágenes del satélite Landsat 5 por lo cual se 
utilizaron las bandas 4 y 3, para el año 2018 se descargaron imágenes del satélite Landsat8, 
utilizando las bandas 5 y 4, todos los índices de los diferentes años dieron valores entre los 
rangos de (1 -1), lo cual nos indica los valores negativos cuerpos de agua, valores entre 0 y 
0,2 indica suelo desnudo, entre 0,2 y 0,4, cobertura de pasto y sabanas vegetación rala, y 
valores superiores a 0,4 la vegetación  que corresponde a la cobertura de los diferentes tipos 
de bosque presentes en la zona de estudio. 

 

7.8. MAPA DEL ÍNDICE NDVI PARA EL AÑO 1998. 

 

El rango de valores esta entre (0.81 y  - 0.37), su media es 0.18 y su desviación estándar es 
de 0.16los tonos oscuros corresponden a valores por debajo de 0.3, a coberturas de agua y 
suelos desnudos o inundados, los valores más claros o amarillos a cultivos en desarrollo, 
pastos o sabanas y los colores verdes a zonas con vegetación más densa cultivos en su 
máximo desarrollo y bosques. 
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Mapa 5. Índice NDVI Año - 1998 

Fuente: Autor Estudio 
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7.9.MAPA DEL ÍNDICE NDVI PARA EL AÑO 2010. 

 

El rango de valores esta entre (0.74 y  - 0.20), su media es 0.28 y su desviación estándar es 
de 0.15, los tonos rojizos y naranja corresponden a valores por debajo de 0.3, coberturas de 
agua y suelos desnudos o inundados, los valores más claros o amarillos a cultivos en 
desarrollo, pastos o sabanas y los colores verdes a zonas con vegetación más densa y 
cultivos en su máximo desarrollo y  bosques. 

 
Mapa 6. Índice NDVI Año - 2010 

Fuente: Autor Estudio 
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7.10. MAPA DEL ÍNDICE NDVI PARA EL AÑO 2018. 

 

El rango de valores esta entre (0.77 y  - 0.17), su media es 0.46 y su desviación estándar es 
de 0.14, los tonos rojizos y naranja corresponden a valores por debajo de 0.2, coberturas de 
agua y suelos desnudos o inundados, los valores más claros o amarillos a cultivos en 
desarrollo, pastos o sabanas y los colores verdes a zonas con vegetación más densa y 
cultivos en su máximo desarrollo y  bosques. 

 
Mapa 7. Índice NDVI Año - 2018 

Fuente: Autor Estudio 
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7.11. CÁLCULO ÍNDICE ESPECTRAL SAVI (SOIL ADJUSTED 
VEGETATION INDEX). 

Se utilizó para el caculo de este índice la formula SAVI =[(IRC–R)/(IRC+R+L)] (1+L), 
utilizando como valor L = 0,5 el que es afin con la mayoría de coberturas, para los años 
1998 y 2010 se descargaron imágenes del satélite Landsat 5 por lo cual se utilizaron las 
bandas 4 y 3, para el año 2018 se descargaron imágenes del satélite Landsat8, utilizando las 
bandas 5 y 4, todos los índices de los diferentes años dieron valores entre los rangos de (1 -
1), tiene  en cuenta la reflectividad del suelo y permite aislar la información que aporta la 
vegetación, de la que procede del suelo que está bajo ella, es complementario al índice 
NDVI. 

7.12. MAPA DEL ÍNDICE SAVI PARA EL AÑO 1998. 

 
Mapa 8. Índice SAVI Año - 1998 

Fuente: Autor Estudio 
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El rango de valores esta entre (0.66 y  - 0.15), su media es 0.18 y su desviación estándar es 
de 0.09, los tonos claros son coberturas de agua, los tonos café a suelos desnudos, los 
valores más claros o amarillos a cultivos en desarrollo, pastos o sabanas y los colores 
verdes a zonas con vegetación más densa y cultivos en su máximo desarrollo y  bosques. 

 

7.13. MAPA DEL ÍNDICE SAVI PARA EL AÑO 2010. 
 

 
Mapa 9. Índice SAVI Año - 2010 

Fuente: Autor Estudio 
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El rango de valores esta entre (0.74 y  - 0.20), su media es 0.08 y su desviación estándar es 
de 0.04, los tonos rojos oscuros son coberturas de agua, suelos desnudos o inundados, los 
valores más claros o amarillos a cultivos en desarrollo, pastos o sabanas y los colores 
verdes a zonas con vegetación más densa y cultivos en su máximo desarrollo y  bosques. 

 

7.14. MAPA DEL ÍNDICE SAVI PARA EL AÑO 2018.  

 

 
Mapa 10. Índice SAVI Año - 2018 

Fuente Autor Estudio 
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El rango de valores esta entre (0.62 y  - 0.07), su media es 0.30 y su desviación estándar 
es de 0.09, los tonos violetas son coberturas de agua, suelos desnudos o inundados, los 
valores más claros o amarillos a cultivos en desarrollo, pastos o sabanas y los colores 
verdes a zonas con vegetación más densa y cultivos en su máximo desarrollo y  
bosques. 

7.15. CÁLCULO ÍNDICE CLIMÁTICO CALDAS LANG 

 

Para el cálculo del índice Climático Caldas Lang, se calculó primero el índice de 
pluviosidad de Lang, que para la zona da Árido  por estar el valor entre 20 y 40,  para luego 
sumarlo al mapa de pisos térmicos de Caldas y así lograr el respectivo mapa del índice 
Climático Caldas Lang, al combinar la pluviosidad de una zona con sus respectivos pisos 
térmicos, que en este zona están entre350m  y 800 m, piso cálido y  entre 800 m y 1600 m 
piso templado. 

7.16. MAPA ÍNDICE CLIMÁTICO CALDAS LANG PERIODO 1963 – 
2014. 
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 Mapa 11. Índice Climático Caldas Lang Periodo 1963 - 2014 

Fuente: Autor Estudio 
 

El rango de valores esta entre 11 y 21, su media 12.12 y su desviación estándar 2,58, se 
obtienen 3 rangos que son 11, 12 y 21, el primer número de la cifra representa el piso 
térmico para estas cifras el 1 es piso térmico cálido y 2 piso térmico templado, el segundo 
número de la cifra representa la pluviosidad, para el caso 1 es árido y 2 es húmedo, por eso 
11 corresponde a  cálido árido, 12 a cálido húmedo y 21 a templado árido, las alturas de 
menores de 800 metros tienen pisos térmicos cálidos, las que están entre 800m y 1600m 
tienen pisos térmicos templados, como se puede ver en el mapa 11.  

 

7.17. DISCUSIÓN DE RESULTADOS 

 

Con base en los análisis de los resultados obtenidos, se puede concluir sobre el proceso de 
desertificación en el ecosistema estratégico “Desierto de La Tatacoa”, lo siguiente: 
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En lo concerniente a coberturas vegetales y usos del suelo para el periodo 1993 – 2018, el 
año 1998 en la cobertura de suelo desnudo presenta un incremento de más del 8%  con 
respecto a los años 1993, 2010 y 2018, que presentan una diferencia del 2% al 3%, esto 
puede ser el resultado que la imagen que se analizó corresponde al mes de junio el cual 
presenta normalmente la mayor época seca de todo el año. 

Los resultados en lo referente a la cobertura de bosque muestran como lo dice en su 
proyecto Qiu et. al. (2018), que el ecosistema o región presenta una recuperación entre los 
años 1993 y 2018 del 0.3%  en su cobertura de bosque. 

Al analizar los mapas de los índices de vegetación  NVDI y SAVI, se puede observar que la 
región que presenta la mayor cobertura de suelo desnudo y pastos es la parte central y sur 
de la zona de estudió, evidenciando más este fenómeno en los mapas del año 1998, la 
mayor cobertura vegetal densa se encuentra en la zona Este y Norte,  así como también la 
zona aledaña a los cauces de agua, algunos cultivos se muestran como suelo sin cubierta 
vegetal o con una vegetación menos vigorosa, esto puede ser el resultado que como son 
cultivos de arroz el suelo estaba encharcado o están en su primera etapa del periodo 
vegetativo, al igual el índice SAVI del año 2018 nos muestra con una mayor detalle en la 
parte Norte – Oeste  la zona donde están los lagos de la piscícola que allí existe . 

Al calcular el índice climático de Caldas-Lang se puede ver que existen  solo zonas áridas y 
secas y que los  ecosistemas presentes  en la zona  todavía no han llegado al punto extremo 
de desierto. 
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8. CONCLUSIONES 
 

 
Del área de estudio 51773,4 Hectáreas correspondiente al 100% están afectadas por el 
primer indicador de criticidad en desertificación, con un promedio para el periodo de los 25 
años la cobertura vegetal – Se (Suelo expuesto) – 13875.3 Hectáreas (26,8%), y 21020 
Hectáreas  en pastos (40,7%) y en bosques 13150,4 Hectáreas (25,4%). 
 
Los sectores que mayor riesgo de desertificación presentan son la zona centro y sur pero se 
evidencia un leve aumento hacia la parte norte. 
 
La velocidad promedio de crecimiento del proceso de desertificación en el área de  estudio,  
para el periodo comprendido entre los años 1993 a 2018 fue de 46.8  Has/año, con los datos 
de  la cobertura de suelo expuesto. 
  
Se observó que el ecosistema conserva su capacidad auto-regenerativa natural en cuanto se 
refiere al área ocupada por la cobertura de bosques para el periodo de tiempo entre los años 
1993 a 2018, logrando aumentar su área en esta cobertura de 11521,8 Hectáreas  a 14681.1 
Hectáreas con un crecimiento de 3160 Hectáreas. 
 
Con base en la estimación del índice de aridez, por el método Caldas Lang, se puede 
observar que todos los valores obtenidos apuntan a zonas clasificadas como áridas, de 
acuerdo a los registros de precipitación y temperatura, y los pisos térmicos son cálidos y 
templados.  
 
Calculando los índices espectrales NVDI y SAVI, se muestran que están relacionados no 
hay diferencias entre sus rangos, pero para poder hacer más eficiente su análisis, se debe 
además contar con imágenes satelitales de una mayor resolución espacial, para la cobertura 
de cultivos, esta puede presentar inconsistencias ya que acorde al periodo vegetativo del 
cultivo y a la siembra en algunos casos esta cobertura se muestra como suelo desnudo o 
como pasto.   
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9. RECOMENDACIONES 
 
 

• Resulta indispensable determinar la capacidad de carga que puede soportar este 
ecosistema, incluyendo todas las actividades que actualmente se desarrollan y las que estén 
proyectadas. 
 
•  Se plantea la necesidad de tener más estaciones meteorológicas dentro de la zona, con el 
objeto de contarlas como herramientas de monitoreo, con información actualizada sobre el 
clima, y así revisar y actualizar las medidas de manejo a aplicar. 
 
• Es imprescindible adelantar procesos de capacitación sobre manejo sostenible de 
suelos, orientados a los pobladores de la zona, con el objeto de garantizar sus actividades 
productivas pero sin aumentar los niveles de degradación de las zonas afectadas. 
 
• Es fundamental que las autoridades gubernamentales con jurisdicción sobre la zona 
de estudio, ejerzan mayor control a las actividades que se adelantan para evitar que el 
proceso de desertificación siga en aumento desmesurado.  
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